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BLL (Basis Locon Laptop)

Basis Locon Laptop is a Windows Application that runs on laptops and allows the user to connect devices via local 
(USB) or remote (DOCSIS) interface. The remote connection requires a network connection and device equipped with a 
Technetix DOCSIS transponder. The application allows users to setup and configure all aspects of the device.

Two versions of the application are available:

■■ The LITE version provides functionality for basic control over devices
■■ The FULL version allows the user to freely change any aspect of the amplifier with enhanced functionality

The FULL version has enhanced functionality allowing the user to do the following:

■■ Change the amplifier type by setting the control module to 'free mode' using the unlock function
■■ Change the upstream slope point (Diplexer Type)
■■ Change the downstream EQ hinge point (End Frequency)
■■ Save custom defaults
■■ Unlock the control module

Prerequisites

Operating system:

■■ Microsoft .NET Framework 4.5.2
■■ Windows Vista (32 or 64 bit)
■■ Windows 7 (32 or 64 bit)
■■ Windows 8 (32 or 64 bit)
■■ Windows 10 (32 or 64 bit)

Hardware:

■■ USB interface
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Supported devices

Amplifiers

■■ DBC-1200 (S)
■■ DBD-1200
■■ DBE-1200 (S)

Control modules

■■ DBDCM-C1: v1.06, v1.08, 1.09
■■ DBDCM-A1: v1.03, v1.04, v2.x
■■ DBDCM-B2: v2.22

Upstream modules

■■ DBUS-A1
■■ DBUS-C1
■■ DBUS-D1
■■ DBTX-A1

Downstream modules

■■ DBDS-A1
■■ DBDS-B2-x
■■ DBDS-B4-x
■■ DBDS-B5-1
■■ DBDS-B6-1
■■ DBDS-B7-x
■■ DBDS-D1
■■ DBDS-F1
■■ DBDS-F2
■■ DBDS-F5-1
■■ DBRX-A1
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Installation process

Using Windows Vista, 7 or a newer operating system (Windows 10) you will be prompted to allow the set-up process to use 
administration rights. This will have to be allowed for a successful installation. Simply click ‘Yes’ to allow the application to 
make changes on your computer.

1. Run Setup File

Click ‘Next’ on the welcome screen when ready to continue.

Once you have read and accepted the terms, select ‘I Agree’ and click ‘Next’.

2. Agreeing to the End User License agreement



4Mar/2019 - V4 / Software V 3.6.0 Technetix Group Limited

User Manual
BLL

Change the folder and choose the options ‘Just me’ and click ‘Next’

Once ready, click ‘Next’ to install.

Installation progress

3. Select your installation folder

4. Confirmation of installation

5. Installation
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Once the software has been successfully installed, the ‘Installation Complete’ screen will appear.
Click ‘Close’ to finish the process.

Users can start the application by following the shortcut path below:
Start > All Programs > Technetix > BLL-> BLL 3 or BLL Lite 3

6. Installation complete

Select ‘BLL 3’ or ‘BLL Lite 3’ to run the application.

7. Start the application
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Application interface

The following layout shows the BLL application user interface when it is disconnected from the USB device.

Figure 1, Main application widow

12

3

4

5

Figure 2, Menu changes when device is connected

(1) Menu bar
(2) Toolbar
(3) Work area
(4) Status bar
(5) Device type and status (offline/online)
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Menu and toolbar description

File menu

Load back up file
Loads the saved device settings from the back up file. The user can define the default back up file location in [Menu-
>Preferences]. This option is disabled when the device isn’t loaded (online/offline).

Toolbar (2) icon:  

Save new back up file
Allows the user to back up the device, the [Amplifier Name] must be filled. The user can define the default back up file 
location in [Menu->Preferences]. This option is disabled when device isn’t loaded (online/offline).

Toolbar (2) icon:  

Connect to amplifier
Establishes a connection with the device using the local (USB) or remote (DOCSIS) interface. The remote connection 
requires a network and the device to be equipped with a Technetix DOCSIS transponder. Please refer to the DOCSIS 
Control for more details.

Toolbar USB (2) icon:  

Toolbar DOCSIS (2) icon:  

Close amplifier
Disconnect the application from any connected device.

Toolbar (2) icon:  
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Preferences

Preferences contains optional settings

■■ Disable/enable autoload - disabling this will stop the application automatically detecting the amplifier  
when connected to the USB port.

■■ Disable/enable firmware check on connected device

■■ Path to firmware upgrade files.
■■ SNMP Port
■■ Disable Connection Check - In some cases,  a network may have been configured to block 'ping' checks.  
This will lead BLL to assume the transponder is offline and displaying the following error. Tick this box  
to stop software running ping checks.

Exit
Closes all connections and exit from the application.

Work Offline menu

DBUS-A1, DBDCM-C1, DBDS-A1
DBUS-A1, DBDCM-A1, DBDS-A1
DBUS-A1, DBDCM-C1, DBDS-B2
DBUS-A1, DBDCM-A1, DBDS-B2
DBUS-A1, DBDCM-A1, DBDS-B2ET
DBUS-B2, DBDCM-A1, DBDS-B2ET

DBC-1200:

DBUS-C1, DBUS-D1, DBDCM-A1,
DBDS-B4, DBDS-F2, DBDS-F2

DBE-1200: 

DBUS-A1, DBDCM-C1, DBDS-A1, DBDS-D1
DBUS-A1, DBDCM-A1, DBDS-A1, DBDS-D1
DBUS-A1, DBDCM-C1, DBDS-B2, DBDS-F1
DBUS-A1, DBDCM-A1, DBDS-B2, DBDS-F1
DBUS-A1, DBDCM-A1, DBDS-B2ET, DBDS-F1
DBUS-B2, DBDCM-A1, DBDS-B2ET, DBDS-F1

DBD-1200:
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Tools

The tools menu is only accessible when the application is connected to the amplifier.

Figure 3, Tools menu

Save custom default
Save the current device settings into the device memory as a restore point (back up). This back up option will initially be 
set in production with the type defaults and will be used to restore the amplifier to factory defaults for its type. 

Note: This option is not available in BLL Lite version.

Restore custom default
Restore the settings saved in the device back up memory of the connected amplifier to the user interface. To apply 
changes to the amplifier, press the ‘Send to amp’ button.

Reset
This option performs a software reset of the amplifier.

Unlock amplifier type
This option is for moving the Control Module to the new amplifier type, the [amplifier template] setting needs to be 
changed to ‘0: Free’. This can be done by changing the amplifier template from the dropdown control or alternatively via 
Tools -> ‘Unlock amplifier type’ in the BLL full version. As a result, in the BLL Lite version, the user can change the amplifier 
type in which control module is installed. Please refer to the ‘Moving a control module’ section of this user manual for 
further information.

Note: This option is not available in the Lite version of BLL.

Firmware Upgrade
Enables the user to upgrade the firmware installed in the amplifier to a newer version. Please refer to the ‘Firmware 
Upgrade’ section of this user manual for more information.

Note: This option is not available in the Lite version of BLL.
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Help menu
This menu displays the ‘About’ detail with a link to the end-user license agreement (EULA) and the Supported Devices 
(please refer to the ‘Supported Devices’ section of this user manual).

Figure 4, ‘About’ under Help menu
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Working space

Figure 5, Application layout when device is connected

(1) Device type and status
(2) Device diagram (depends on device type)
(3) Device details (depends on device type)

Device type and status
Provides an indication of device type and status. A green circle and text ‘(On-Line)’ indicates a connected device, if circle is 
grey with ‘(Off-Line)’ label, the application has lost its connection with the device or is in offline mode.

Device diagram
The diagram is shown when the device is connected or loaded in offline mode. The appearance of the diagram depends 
on the device type and configuration.

Device details panel (table)
The amplifier can be adjusted via the block diagram or the device details table. The controls on the diagram and panel are 
connected and a change on the panel is reflected on diagram and vice versa.
The user can adjust any electronic controls based on specific amplifier configuration.

Table contains controls including:

■■ Amplifier – main amplifier information

■■ Control module

■■ Compensation – adjust and calibrate compensation parameters

■■ Upstream module settings

■■ Downstream module settings

1

2 3
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Amplifier section

Figure 6, Amplifier information

Amplifier Name
The amplifier name is for the user and can be used 
for any purpose.
The field specification:

■■ Is required for saving back up files

■■ Maximum length 20 characters

■■ Saved in device memory only for DBDCM-A1 and 
DBDCM-B2

Amplifier Address
The amplifier address (modem address) is used to store the 
user defined FSK address.
The field specification:

■■ Maximum length 16 characters

■■ Only available for firmware version 2.xx +

Amplifier Description
Amplifier description field allows the user to store any 
general customised information.
The field specification:

■■ Maximum length 42 characters

■■ Only available for DBDCM-A1 and DBDCM-B2

Amplifier Template
The device has several predefined ‘templates’ to match 
specific use case applications. Changing the device 
template, the values, the maximums and offsets are reset 
to new template default values. To apply the template, the 
user must click the ‘Send to amp’ button.
The field specification:

■■ Option is not available in BLL Lite version

Diplexer Type
Users can change the diplexer’s type by clicking on the 
‘diplexer type’ drop down box in the table and selecting 
the new type. The new type should match with the diplexer 
type installed in the amplifier. Due to physical limitations, 
the selected diplexer will affect the maximum achievable 
attenuation and gain. To apply the diplexer, the user must 
click the ‘Send to amp’ button.
The field specification:

■■ Available options: 
DBDIP-01 (65/85MHz), DBDIP-02 (85/105MHz), 
DBDIP-03 (204/258MHz), DBDIP-04 (42/54MHz), 
DBDIP-05 (85/102MHz)

■■ Option is not available in BLL Lite version
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End Frequency
The end frequency indicates the ‘downstream hinge point’ and allows the user to select which end frequency to use 
(e.g.: 862 MHz or 1 GHz); this will ensure the appropriate attenuation correction is used when attenuation is adjusted by the 
user. Due to physical limitations, the selected end frequency will affect the maximum achievable attenuation and gain.

The field specification:

■■ Available options: 750MHz, 862MHz, 1GHz (1006MHz), 1.2GHz (1218MHz)

■■ Option is not available in BLL Lite version

Control module section

Figure 7, Control module parameters

Unique Address
Each DBDCM-A1 and DBDCM-B2 module has a unique ID.
The field specification:

■■ Available for DBDCM-A1 and DBDCM-B2

■■ The ID is used as device FSK address for DBDCM-A1. 
Please refer to DBDCM-A1 FSK control module for 
further detail 

FSK Frequency
The FSK frequency is used to receive communication 
(commands) from the RF Gateway (PGR-121/122).
It must be set to the same frequency as that of the PRG-
121/122. Please refer to DBDCM-A1 FSK control module for 
further detail.
The field specification:

■■ Only available for DBDCM-A1

Inter-Step Delay
The inter-step delay is used to gradually move the attenuators 
and equalisers in 0.5 dB steps. When enabled and when an 
attenuator or equaliser’s electronic control has been changed, 
the amplifier will move the electronic control in 0.5 dB steps 
to the new set value. If this is not enabled, the amplifier will set 
the control directly to the new value in one step.
The field specification:

■■ Delay between steps is 15 ms 

Auto Disable IDS
Enable/disable IDS switch to auto return to default value (0 dB). 
This functionality only applies to local connection (USB).
The field specification:

■■ Default delay 15 min

■■ Not applicable for DBDCM-C1 firmware version 1.06

DOCSIS Section
DOCSIS section is only available for DBDCM-B2 control 
modules. There are two modes, the first one is the local 
connection through USB (Figure 6) and the second one is the 
remote connection (Figure 7)
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Figure 8, Local connection (USB)

Figure 9, Remote connection

Compensation section

Please refer to the ‘Compensation’ section of this user manual for further detail.

Method
Compensation method OFF, ATC, AGC, ASLC (please see the ‘Compensation’ section).

Trigger Mode
Trigger mode: how the compensation is triggered.

Pilot (Low) Frequency
For AGC is Pilot Frequency
For ASLC is Pilot Low Frequency

Pilot High Frequency
Is enabled\visible only for ASLC
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Ports status
Number of ports is dependent on the amplifier type:
DBC-1200 and DBC-1200S is 1 port
DBD-1200 is 2 ports
DBE-1200S is 3 Ports
DBE-1200 is 3-4 ports

Start-Stop button
This starts a calibration process, and if successful, the button will change to display [Stop]. This indicates the Compensation 
is running. For details please see the ‘Compensation’ section.

Trigger Now button
The manual trigger allows the user to execute alignment.

Configuration button
Open the Compensation Settings Window, for details, please see the ‘Compensation’ section.
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Upstream module section

The number of upstream module sections depends on a number of upstream modules installed in an individual amplifier, 
and the parameters depend on individual amplifier settings. The user can change the parameter values based on the 
specific amplifier settings by clicking the increase/decrease buttons and the change values in the drop down controls.

DBUS-A1

Figure 10, DBUS-A1 module

Figure 11, DBUS-C1

Supported by DBC-1200, DBC-1200S and DBD-1200.

DBUS-C1

Supported by all devices.
Exception:

■■ DBC-1200, DBC-1200S – Output IDS 2 and ports switches are not available

■■ DBD-1200 - port 2 switch is not available
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Figure 12, DBUS-D1

Figure 13, DBTX-A1

DBUS-D1

Supported by DBE-1200, DBE-1200S
Exception:

■■ DBE-1200S - Output IDS 2 and port 2 switch is not available 

DBTX-A1

Supported by all devices
Exception:

■■ DBC-1200, DBC-1200S – laser 2 is a bypass board only, attenuation port 2 and output IDS 2 are not available

■■ DBE-1200S second upstream slot - laser 2 is a bypass board only, attenuation port 2 and output IDS 2 are not available
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Downstream module section

The number of downstream module sections depends on the number of downstream modules installed in an individual 
amplifier, and the parameters depend on the individual amplifier settings. The user can change the parameter values based 
on the specific amplifier settings by clicking increase/decrease buttons and changing values in the drop-down controls.

DBDS-A1 and DBDS-Bx-x

Figure 14, DBDS-A1 and DBDS-Bx-x modules family

Figure 15, DBDS-Fx-x modules family

■■ DBDS-A1 and DBDS-B2-x supported by DBC-1200, DBC-1200S, DBD-1200
■■ DBDS-B4-x, DBDS-B5-1, DBDS-B6-1, DBDS-B7-x supported by all devices

DBDS-Fx-x

■■ DBDS-F1 supported only by DBD-1200
■■ DBDS-F2, DBDS-F5-1 supported by DBD-1200, DBE-1200 and DBE-1200S

■■ Supported by all devices

DBRX-A1

Figure 16, DBRX-A1
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DOCSIS Control

The BLL has the ability to remotely control device equipped with the Technetix DOCSIS transponder.

Connection
To connect the device with the DOCSIS transponder please use menu [File->Connect Amplifier->DOCSIS] or
use the toolbar icon. 

IP Address
Technetix DOCSIS transponder IP address.

Community string
Text string that acts as a password and is used to authenticate messages sent between BLL and Technetix DOCSIS 
transponder. The community string is sent in every packet between the manager and the agent.

Connect button
Initiate connection with Technetix DOCSIS transponder. If successful, it will return DOCSIS detail containing transponder 
name, firmware version and date.

Accept button
After successful connection, the accept button allows connection to a device.

The device controls work exactly as for local connection.

DBDCM-A1 FSK control module

The DBDCM-A1 receives downstream FSK messages from the headend and has inbuilt ALSC and AGC compensation processes.

Key concept
The DBDCM-A1 has one tuner used for receiving the FSK messages and ALSC/AGC compensation processes.
With ALSC/AGC and FSK messaging enabled, the system needs to synchronise when each amplifier runs the 
compensation and is available to receive FSK control messages. If the BLL application is connected to the DBDCM-A1 
module, all FSK messaging will be ignored until the USB connection is removed.
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FSK messaging
FSK messages are only sent downstream from the headend via a PRG-121/122 gateway.
The following controls are currently used over FSK:

■■ Ingress control reduce upstream by 0 dB
■■ Ingress control reduce upstream by -6 dB
■■ Ingress control disconnect upstream -40 dB

When the compensation method is active the FSK controls are stopped.

Unique address 
Each DBDCM-A1 is given a unique ID:

■■ This ID is used to address the device and send FSK commands to each individual device
■■ This ID should be recorded and entered in the TxNMS

FSK frequency
This should be set to the same frequency that the PRG-121/122 is transmitting on. FSK frequency settings available for 
DBDCM-A1 control modules only.



21Mar/2019 - V4 / Software V 3.6.0 Technetix Group Limited

User Manual
BLL

Compensation

Compensation settings

Compensation method
Possible choices:

■■ OFF compensation is off and the signal isn’t adjusted

■■ ATC (Automatic Temperature Control) gain is adjusted according to temperature function

■■ AGC (Automatic Gain Control) gain is adjusted for selected pilot frequency

■■ ASLC (Automatic Slope Level Control) gain and slope is adjusted for selected low and high pilot’s frequency

Trigger Method
Possible choices:

■■ Local (preferred option) 
The compensation is triggered by internal timer (please see Local Timeout).

■■ Remote 
The compensation is triggered only by remote command. (If this option is chosen the timers are disabled).

■■ Auto 
This option will use the remote triggers unless the remote trigger was not detected for the time management period 
(Remote timeout), at which point it will fall back to locally trigger (Local timeout) itself until the remote triggers are 
detected again (please see Remote Timeout).

Note: This field is not available for OFF and ATC compensation method

Compensation status
This indicates the status of compensation, whether it is INACTIVE or ACTIVE.

Calibration button
Execute the calibration and resetting timers.

Note: This field is not available for OFF and ATC compensation method



22Mar/2019 - V4 / Software V 3.6.0 Technetix Group Limited

User Manual
BLL

Frequency settings

Pilot (Low) Frequency
Only available for AGC and ASLC.

■■ AGC (Pilot Frequency) min 85 MHz and Max 1002 MHz

■■ ASLC (Pilot Low Frequency) Min 85 MHz and Max 500 MHz

Note: Changing state will require the system to execute calibration.

Pilot (High) Frequency
Only available for ASLC

■■ Min 500 MHz and Max 1002 MHz

Note: Changing state will require the system to execute calibration.

Ports status
The number of ports depends on the device type and configuration. Please see Port Status Values.

DBC-1200 and DBC-1200S
Port 1 status

DBD-1200
Port 1 status
Port 2 & 3 status

DBE-1200S
Port 1 status
Port 2 status
Port 3 status

DBE-1200

Option 1

■■ Port 1 status

■■ Port 2 status

■■ Port 3 & 4 status 

Option 2

■■ Port 1 status

■■ Port 2 status

■■ Port 3 status

■■ Port 4 status
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Port status values
Port Status: Firmware version 1.03 and 1.04 (DBC and DBD amplifiers).

Port Status: Firmware version 2.00.

State Description

Disabled Adjusted but ASLC/AGC is not enabled

Not adjusted The pilot has not been adjusted

Active Busy with ASLC/AGC

Invalid target level measured Target level is not stable for ASLC/AGC. It is not possible to take a valid measurement

Not aligned Enabled and adjusted but not triggered yet

Invalid measurement After three failed measurement attempts it is not possible to take a valid measurement

Not possible to align One (or both) pilots are too far from the targets. Out of window

Active window reached Not possible to align before active window is reached

Could not reach target The required correction cannot be performed

Aligned Pilots are successfully aligned

State Description

Port OK A3C successfully connected

Cannot reach value The required correction cannot be made because of the switch limits

No switch detected No switches are defined for A3C in the detected module

See port 1 Module 2, 3 and 4 cannot be adjusted because of the A2C status of module 1

Is adjusted but not enabled A2C is adjusted (configured) but not enabled

Not adjusted A2C is not (yet) adjusted (configured)

Align A2C is active (align)

Not Align A2C is adjusted (configured) and enabled but not yet triggered

Invalid target level A2C cannot run a valid target level measurement. Signal not suitable for A2C

Invalid measurements A2C cannot run a valid level measurement. Signal not stable

Pilot(s) out of window A2C cannot align because one or both pilots are too far from the targets

Maximum attempts is reached A2C cannot align before the maximum attempts is reached

A3C – refer to ATC, AGC and ASLC
A2C – refer to AGC and ASLC
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Advanced settings

Local timeout
Used when the trigger mode is set to Local Mode (default) or the Remote Timeout has expired.
A compensation cycle is started when the Local Timeout expires.

The default timeout is 10 minutes.

Remote timeout
Used when the Trigger Mode is set to Auto mode. The Remote Timeout is reset on each received FSK compensation 
trigger message. When the Remote timeout expires the Local Timeout is used to trigger the compensation cycle. As 
soon as an FSK trigger message is received, again the compensation cycles will be triggered by the central management 
system via the FSK trigger message.

The default management timeout is 3 hours.

Active Window (Attempts)
The active window defines the maximum number of correction attempts per compensation cycle. Each correction attempt 
consists of sampling the pilot(s) and correcting by 0, +0.5dB or -0.5dB. If on the first attempt the sampled pilot is more than 
the upper limit or less than the lower limit the attenuation and equalise setting from before the compensation cycle are 
restored and no correction is made for this cycle. One active attempt takes approximately 2 - 12 seconds, depending on 
compensation method and signal stability.

The default is 17 attempts (taking no more than 3 minutes).

Lower Limit
This defines the lower limit that the compensation can correct. On the first attempt of the compensation cycle the signal 
is checked to see if it is within the permitted limits. If the sampled pilot is outside the permitted range no compensation 
is applied.

The default lower limit is 5 dB

Upper Limit
This defines the upper limit that the compensation can correct. On the first attempt of the compensation cycle the signal 
is checked to see if it is within the permitted limits. If the sampled pilot is outside the permitted range no compensation 
is applied.

The default upper limit is 5 dB
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Moving a control module

To allow a control module to be moved, the FULL version of the BLL software enables the type to be set to ‘Type 0: Free’. 
This can be done via the drop-down type list or the ‘Tools > Unlock amplifier type’ command.

This will allow the LITE BLL version to then set the type of the amplifier in which the control module is now fitted. 

Notes

■■ The LITE version of the BLL software will force the user to set the new type, which will reset the other settings of 
the amplifier.

■■ The FULL version user should not leave the amplifier in the 'Type 0’ state. When a LITE user connects the amplifier 
next time, they will have to reset the type.
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Firmware upgrade

Warning: 

■■ The firmware upgrade process could damage your amplifier

■■ Do not disconnect the computer from the amplifier while running this upgrade

■■ Do not disconnect the power supply to any electronic device while running this upgrade

■■ Make sure you a have reliable power supply

■■ Make sure all devices are connected properly

■■ Do not interrupt the upgrade process under any circumstances

■■ Do not restart/shut down your computer while you are doing this upgrade

■■ Do not install any hardware or software while you are doing this upgrade

Manual method

Connect the USB with the amplifier and run the BLL application. Once the application is loaded on the screen go to the 
Tools menu and select Firmware Upgrade.
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Select ‘Yes’ when you receive the upgrade confirmation message.

Select the ‘Connect’ button on the firmware upgrade window. 

Once the ‘Start Upgrade’ button is enabled, click on it.
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After successful completion of the upgrade process you will get a confirmation message:

Automatic method: 
Connect the USB with the amplifier, run the BLL application and select ‘Yes’ on the upgrade confirmation message: 

Select the ‘Connect’ button on the firmware upgrade form:
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Once the ‘Start Upgrade’ button is enabled, click on it:  

After a successful upgrade you will get a confirmation message:
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